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21 Pengertian Rancang Bangun

Rancang Bangun (desain) adalah tahap dari setelah andlisis dari siklus
pengembangan sistem yang merupakan pendefinisian dari kebutuhan-kebutuhan
fungsional, serta menggambarkan bagaimana suatu sistem dibentuk yang dapat
berupa penggambaran, perencanaan, dan pembuatan sketsa atau pengaturan dari
beberapa elemen yang terpisah ke dalam satu kesatuan yang utuh dan berfungsi,
termasuk menyangkut mengkonfigurasikan dari komponen-komponen perangkat

keras dan perangkat lunak dari suatu sistem. (Jogiyanto, 2012)
2.2 Pengertian Aplikas

Aplikas berasal dari kata application yang artinya penerapan, lamaran,
penggunaan. Secara istilah aplikasi adalah program siap pakal yang dibuat untuk
melaksanakan suatu fungsi bagi penguna atau aplikasi yang lain dan dapat

digunakan oleh sasaran yang dituju.
Aplikasi menurut para ahli adalah sebagai berikut :

a.  (Jogiyanto, 2008) adalah program yang telah jadi dan siap digunakan atau
program yang dibuat sendiri.

b. (Pramana, 2010) adalah suatu unit perangkat lunak yang dibuat untuk
melayani kebutuhan akan beberapa aktivitas seperti system perniagaan, game
palayanan masyarakat, periklanan, atau semua proses yang hampir dilakukan

manusia.



2.2.1 Klasifikasi Aplikasi

Aplikas dapat digolongkan menjadi beberapakelas, antaralain:
Perangkat lunak perusahaan (enterprise)

Perangkat |unak infrastruktur perusahaan

Perangkat lunak informasi kerja

Perangkat lunak media dan hiburan

Perangkat lunak pendidikan
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Perangkat |unak pengembangan media
Perangkat lunak rekayasa produk

©

2.3 MediaPembelajaran

(Septilia Arfida dan Rahman E. Harahap, 2014 ) mengemukakan bahwa media
berasal dari bahasa latin dan merupakan bentuk jamak dari kata medius yang
berarti tengah, perantara atau pengantar. Dengan kata lain, media adalah
komponen sumber belgar atau wahana fisk yang mengandung materi

instruksional di lingkungan siswa yang dapat merangsang siswa untuk belgjar .

(Ossy Dwi Endah Wulansari, TM Zaini, dan Bobby Bahri, 2013) mengemukakan
bahwa media di gunakan proses pembelgaran dengan metode konvensiona
(dide) dan menggunakan buku panduan dan sgenisnya pada hakekatnya
digunakan untuk menunjang proses pembelgaran itu sendiri guna memberikan

pemahaman kepada user tentang materi yang disampaikan.

2.3.1 Ciri-ciri Media Pembelajaran

(Gerlach and Elly dalam Azhar Arsyad, 2011) mengemukakan ciri media
yang merupakan alasan mengapa media perlu digunakan dan hal apa sga
yang dapat dilakukan media apabila guru kurang efisien dalam melakukan

pengajaran :

1) Ciri Fiksatif

Ciri ini menggambarkan kemampuan media merekam menyimpan,
melestarikan dan merekonstruksikan suatu objek atau peristiwa. Sebagai
contoh peristiva sgjarah yang sudah berlalu. Siswa bisa mempelgari



peristiwa-peristiwva bersgarah melaui media pembelgaran berupa
rekaman video, dokumentasi, dan foto-foto.

2) Ciri Manipulatif

Ciri manipulatif erat kaitannya dengan kejadian yang berlangsung berhari-
hari bahkan bertahun-tahun dapat disgikan dalam waktu beberapa menit
sgja. Banyak peristiwa atau objek yang sulit diamati secara langsung
dengan mudah diamati melalui media pembelgjaran berupa rekaman video
dan foto. Sebagal contoh siswa ingin mempelgari perkembangan janin
daam rahim ibu selama sembilan bulan. Melalui bantuan media
pembelgaran, waktu dapat dipersingkat dengan menampilkan hal-hal yang
dirasa penting sgja misalnya, melalui rekaman video.

3) Ciri Distributif

Ciri distributif dari media memungkinkan suatu objek atau keadian
ditransportasikan melalui ruang dan secara bersamaan keadian tersebut
disgjikan kepada siswa dengan stimulus pengalaman yang relatif sama.
Sebagai contoh penggunaan CD, flashdisk, dan sebagainya dapat
memudahkan guru untuk mendistribuskan bahan pembelgaran.
Inforrmasi yang terdapat didalamnya akan selau terjaga sebagaimana
aslinya atau gjeg.

2.3.2 Klasifikasi dan Macam-macam M edia Pembelajaran
(Sanjaya, 2011) mengungkapkan bahwa media pembelgaran dapat
diklasifikasikan menjadi beberapa klasifikas tergantung dari sudut mana

melihatnya.

1. Dilihat dari sifatnya, media dapat dibagi ke dalam :
a. Media auditif, yaitu media yang hanya dapat didengar sga atau
media yang hanya memiliki unsur suara.
b. Media visual, yaitu media yang hanya dapat dilihat dan tidak
mengandung unsur suara.
c. Mediaaudiovisual, yaitu jenis media yang selain mengandung unsur

suara juga mengandung unsur gambar yang bisa dilihat.



2. Dilihat dari kemampuan jangkauannya, media dapat pula dibagi ke
dalam:

a. Media yang memiliki daya liput yang luas dan serentak. Melalui
media ini siswa diharapkan dapat mempelgjari hal atau kejadian-
kgadian yang aktual secara serentak tanpa harus menggunakan
ruangan khusus

b. Media yang mempunyal daya liput yang terbatas oleh ruang dan
waktu

3. Dilihat dari cara atau teknik pemakaiannya, media dapat dibagi ke
dalam:

a. Media yang diproyeksikan, jenis media yang seperti ini
memerlukan alat proyeksi khusus seperti film projector untuk
memproyeksikan film, slide projector untuk memproyeksikan film
dide, dan OHP untuk memproyeksikan transparansi. Tanpa alat
pendukung ini, maka mediatidak akan bisa berfungsi.

b. Mediayang tidak diproyeksikan

Klasifikasi media pembelgaran menurut Rudi Susilana dan (Cepi Riana,
2009) dibagi menjadi tujuh kelompok, yaitu :

1) Media grafis, bahan cetak, dan gambar diam.

2) Media proyeksi diam.

3) Media audio.

4) Media audio visual diam..

5) Mediafilm.

6) Mediatelevisi.

7) Media multimedia.



2.3.3 Karakteristik Pembelajaran Interaktif
Teknik penggunaan media pembelgaran menurut Daryanto (2010) dibagi
menjadi dua yaitu:
1. Penggunaan media berdasarkan tempat
a. Penggunaan di kelas
Media dimanfaatkan untuk menunjang tercapainya tujuan tertentu
dan penggunanya dipadukan dengan proses belgjar mengagjar dalam
kelas. Seorang guru ketika merencanakan media harus melihat tujuan
yang akan dicapai, materi pembelgaran harus mendukung dan
strategi  belgar menggar yang sesual untuk mencapa tujuan
tersebuit.
b. Penggunaan di luar kelas
Media yang digunakan diluar kelas tidak secara langsung
dikendalikan oleh guru atau pengontrolan oleh orang tua siswa.
2. Varias penggunaan media
a. Mediadigunakan secara perorangan
Media dapat digunakan secara perorangan atau individual learning.
Media seperti ini biasanya delengkapi dengan petunjuk penggunaan
yang jelas sehingga orang dapat menggunakan secara mandiri.
b. Mediadigunakan secara berkel ompok
Pembelgjaran dapat berlangsung dengan jumlah siswa yang cukup
banyak atau bersifat kelompok. Media dirancang untuk digunakan
berkelompok juga memerlukan buku petunjuk. Buku petunjuk. Buku
petunjuk ini ditunjukan kepada kelompok tutor atau guru.
Keuntungan belgjar menggunakan media secara berkelompok adalah
dapat melakukan diskusi tentang materi yang sedang dipelgjari.
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24  Pengertian Budidaya

Budidaya Menurut Kamus Besar Bahasa Indonesia, budidaya adalah "usaha yang

bermanfaat dan memberi hasil".
2.4.1 Jenis-Jenis Budidaya
Budidaya Tanaman
Budidaya tanaman mengandalkan penggunaan tanah atau media lainnya di
suatu lahan untuk membesarkan tanaman dan lalu memanen bagiannya
yang bernila ekonomi. Bagian ini dapat berupabiji, buah
/bulir, daun, bunga, batang, tunas, serta semua bagian lain yang bernilai
ekonomi. Kegiatan budidaya tanaman yang dilakukan dengan media tanah
dikenal pula sebagai bercocok tanam (bahasa Belanda: akkerbouw).
Termasuk dalam "tanaman" di sini  adalah gulma laut serta
sggumlah fungi penghasil jamur pangan. Dari pengertian budidaya tanaman
yang di jelaskan saya mengambil beberapa budidaya tanaman perkebunan

yaitu:
1. Budidaya Tanaman Karet

Karet adalah polimer hidrokarbon yang terbentuk dari emuls
kesusuan (dikenal sebagai lateks), diperoleh dari getah beberapa
jenis tumbuhan pohon karet. Sumber utama lateksyang digunakan
untuk menciptakan karet adaah pohon karet (Hevea
brasiliensisMoel.), diperolen dengan cara melukai kulit pohon
sehingga pohon akan memberikan respons dengan mengeluarkan
getah/lateks.

2. Budidaya Tanaman Sawit

Tanaman Kelapa Sawit ( Elaeis guineensis Jack) diduga berasal
dari duatempat, yaitu Amerika Selatan dan Afrika. Spesies Elaeis
oleivera diduga berasaldari Amerika Selatan dan spesies Elaeis

guineensis berasal dari Afrika (Guenia).

Kelapa Sawit adalah tanaman penghasil minyak nabati yang

memilikiberbagai keunggulan dibandingkan dengan minyak yang
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dihasilkan oleh tanamanlain. Keunggulan tersebut di antaranya
memiliki kadar kolesterol rendah, bahkan tanpa kolesterol.

Minyak nabati yang dihasilkan dari pengolahan buah kelapa sawit
berupa minyak mentah ( CPO atau Crude Palm Oil ) yang berwarna
kuning dan minyak inti sawit (PKO atau Palm Kernel Oil) yang
tidak berwarna (jernih). CPO atauPKO banyak digunakan sebagai
bahan industri pangan (minyak goreng danmargarin), industri
sabun (bahan penghasil busa), industri baga (bahan
pelumas),industri tekstil, kosmetik, dan sebagai bahan bakar
aternatif (minyak diesdl).

25 Android

Android menurut (Nazaruddin, 2012) merupakan sistem operasi untuk telepon
seluler yang berbasis Linux. Android menyediakan platform terbuka bagi para
pengembang untuk menciptakan aplikasi mereka sendiri untuk digunakan oleh
bermacam piranti bergerak. Android umum digunakan di smartphone dan juga
tablet PC. Fungsinya sama seperti sistem operasi Symbian di Nokia, iOSdi Apple,
dan BlackBerry OS.

25.1 Sgarah Android

Awalnya perusahaan search engine terbesar saat ini, yaitu Google Inc,
membeli Android Inc, pendatang baru yang membuat perangkat |unak
untuk ponsel. Android Inc. Didirikan oleh Andy Rubin, Rich Milner, Nick
Sears dan Chris White pada tahun 2003. Pada Agustus 2005 Google
membeli Android Inc.

Dimulai pada tahun 2005, Android Inc. Dibawah naungan Google Inc.
Berusasha membuat sebuah operating system mobile baru. Segjak itulah
mulai beredar rumor bahwa Google akan melakukan ekspansi bisnis ke
industri  seluler. Akhirnya pada bulan September 20017 Google
mengajukan hak paten atas produknya yang dinamai Nexus One.
Kemudian pada akhir tahun 2008, dibentuk sebuah tim kerja sama yang
dinamai Open Handset Aliance (OHA). OHA ini terdiri dari beberapa
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produsen perangkat telekomunikasi ternama dunia, antara lain ASUS,
Toshiba, Sony Erickson (sekarang Sony), Garmin, Vodafone, dan
Softbank. OHA bekerja sama untuk mengembangkan sebuah kernel Linux
yang akan dijadikan sebuah program untuk perangkat seluler. Hingga
akhirnya OHA berhasil dan mengumumkan produk operating system
mobile yang diberi nama android. Ponsel yang mendapat kehormatan yang
mencoba pertama kali sistem operasi Android adalah HTC Dream. HTC
Dream dirilis pada bulan Oktober tahun 2008. Sejak saat itu banyak
perusahaan perangkat seluler di duniaikut menggunakan Android sebagai
operating system ponsel mereka.

2.5.2 Komponen Android

Android SDK(Software Development Kit) merupaka sebuah tools yang
diperlukan untuk mengembangkan aplikasi berbasi Android menggunakan
bahasa pemograman Java. Pada saat ini Android SDK telah menjadi alat
bantu dan APl (Aplication Programming Interfence) untuk
mengembangkan aplikasi berbasis android. Android SDK dapat anda lihat
dan unduh pada sSitus resminya, yaitu http//.devel oper.android.com/,
Android SDK bersifat gratis dan bebas anda distribusikan karena Android

bersifat open source.

Berikut adalah garis besar pada arsitektur yang Android miliki:
a. Applications dan widget

b. Application Frameworks

c. Libraries

d. Android Run Time

e

Linux Kernel
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253 Jenisdan Vers Android

Jenis-jenis dan Versi Android diaPntaranya :

a) Android versi 1.0.1.1

Sistem android versi 1.0 ini pertama kali hadir di tahun 2008, tepatnya
pada Oktober 2008. Ponsel pertama yang menggunakan sistem Android
adalah HTC. Pada bulan februari 2009 rilis update pertama android versi
1.1 yang masih belum memiliki nama. Dan untuk android vers
selanjutnya google memutuskan untuk memberi nama versi android
dengan nama makanan ringan, tujuannya adalah agar mudah diingat oleh
para pengguna dan pecinta android.

b) Cupcake (Android versi 1.2 — 1.5)

Nama Cupcake diambil dari sebuah makanan ringan berupa kue kecil yang
dikemas dalam sebuah wadah yang biasanya di sgikan dengan frosting
diatasnya. Dengan penamaan Cupcake ini maka penamaan dari vers

Android dimulai.

¢) Donut (Android versi 1.6)

Vers selanjutnya adalah Donut, vers ini dirilis pada bulan September
2009 tentu donut sudah tak asing lagi bagi telinga orang Indonesia. Donut
adalah sebuah makanan ringan berbentuk bulat yang terdapat lubang di
tengahnya (berbentuk seperti cincin). Versi android ini memiliki fitur foto
dan video dan kamera antarmuka dan integrasi pencarian yang lebih baik.
Sdlain itu ditambahkan juga dukungan untuk ukuran layar yang lebih

besar, dan diberi versi awal fitur navigasi turn-by-turn besutan Google.

d) Eclair (Android versi 2.0-2.1)

Eclair adalah makanan penutup yakni kue yang biasanya berbentuk
persegi panjang yang dibuat dengan krim di tengah dan lapisan cokelat di
atasnya. Di rilis pada bulan Oktober 2009, dengan rilisnya android versi
ini google menambahkan fitur Bluetooth 2.1, Flash dan kamera dengan

digital zoom, multi-touch, live walpaper dan lainnya.
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e) Froyo (Android versi 2.2-2.2.3)

Nama Froyo diambil dari kependekan dari Frozen Yoghurt yaitu yoghurt
yang telah mengalami proses pendinginan sehingga terlihat seperti es krim.
Vers ini dirilis pada bulan Me 2010 dengan update memperbaiki segi
kecepatan dan pengadopsian Javascript dari browser Google Chrome

dengan fitur-fiturnya.

f) Gingerbread (Android versi2.3-2.4)

Nama Gingerbread diambil dari jahe atau cookie dengan rasa khas jahe
yang biasanya berbentuk boneka mirip manusia. Versi ini dirilis pada
bulan Desember 2010. Smartphone pertama yang memakal versi android
ini adalah Nexus S yang dikeluarkan oleh produsen Samsung Android 2.3
Gingerbread ini merupakan OS Android yang paling lama berkuasa
bahkan sampai sekarangpun beberapa vendor masih mengeluarkan ponsel
dengan vers ini. Adapun perbaikan di versi Gingerbread ini adalah
tambahan fitur dukungan untuk SIP internet calling, kemampuan nirkabel
NFC, dukungan untuk dual kamera, dukungan untuk sensor giroskop dan
sensor lainnya, fitur download manager, sgjumlah tweak untuk
penggunaan di Tablet, dan lainnya.

g) Honeycomb (Android versi 3.0-3.2)

Nama Honeycomb diambil dari nama sereal manis yang terbuat dari
jagung rasa madu yang berbentuk sarang lebah, makanan ini yang popul er
sgjak tahun 1965. Untuk versi ini merupakan versi yang ditujukan untuk
gadget Tablet. Android Honeycomb rilis pada Februari 2011, kemudian
upgrade ke versi 3.1 dan 3.2.

h) lIce Cream Sandwich (Android versi 4.0)
Android Ice Cream Sandwich atau biasa dikenal dengan nama Android 4.0
ICS adalah vers terbaru Android yang sangat mendukung baik untuk
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smartphone, tablet, dan lainnya. Android ini rilis pada 19 Oktober 2011.
Yang baru dalam android ini adalah perubahan interface dari android
sebelumnya, antara lain pengoptimalan multitasking, variasi layar beranda
yang bisa disesuaikan dan interaktivitas mendalam serta cara baru yang
ampuh untuk berkomunikasi dan berbagi konten. Nama Ice Cream
Sandwich diambil dari nama makanan dimana lapisan es krim yang
biaanya berupa vanila yang terjepit antara dua cookies coklat dan biasanya

berbentuk persegi panjang.

i) Jelly Bean (Android versi 4.1-4.3)

Android 4.1 Jelly Bean diumumkan pada 27 Juni 2012 pada konferens
Google /0 yang secara resmi dikenalkan ke publik sekitar Oktober 2012.
Vers ini adalah yang tercepat dan terhalus dari semua versi Android. Fitur
baru yang terdapat di vers ini adalah meningkatkan kemudahan dan
keindahan tampilan dari lce Cream Sandwich dan memperkenakan
pengalaman pencarian Google yang baru di Android. Android 4.2 Jelly
Bean juga menawarkan peningkatan kecepatan dan kemudahan Android
4.1 serta mencakup semua fitur baru seperti Photo Sphere dan desain baru
aplikasi kamera, keyboard Gesture Typing, Google Now dan lainnya.
Untuk nama Jelly Bean pastisemua tahu kan, ya nama ini diambil dari

sgjenis permen yang juga populer disebut kacang j€li.

]) KitKat (Android versi 4.4)

Awalnya android vers ini diisukan bernama Key Lime Pie. Namun pada
tanggal Oktober 2013 google merilis kitkat sebagai generasi android
berikutnya. Android versi ini memiliki banyak fitur dan semakin menjakan
para pengguna android. Diantaranya : Immersive mode. Akses kontak
langsung dari aplikasi telepon, google now launcher, dan pastinya

memiliki Interface Ul yang baru
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k) Lollipop (Android vers 5.0)

Android versi 5.0 merupakan versi paling baru dari sistem operasi android.

Android 5.0 sendiri dianggap membawa update yang fantatis, banyak

perubahan yang disertakan Google di dalamnya.

254 Keebihan dan Kekurangan Android

Berikut merupakan kel ebihan dan kekurangan android, diantaranya:

a)
1.

Kelebihan Android

Penggunaan yang didesain mudah pada fitur-fitur aplikasi, serta tidak
sulit untuk dipahami.

Android dapat juga dikatakan sistem operasi berbasis Linux yang open
source. Dengan begitu akan memberikan peluang besar untuk para
developer membuat dan mengembangkan aplikasi-aplikasi yang bagus
dan canggih.

Pengguna dapat dengan bebas untuk memilih aplikasi yang mana sgja
yang ingin digunakan.

Tersediabanyak sekali aplikasi yang dapat digunakan secara
gratis dengan berbaga fungsinya, itu secara resmi tersedia di Google
Play Sore.

Sistem operasi Android bersifat multitasking, yang berguna untuk
menjalankan berbagai aplikas secara mudah, serta dapat menelusuri
apps Android yang diinginkan.

Aplikasi untuk sistem Android juga dikembangkan secara up to date,
sehingga setigp waktu akan muncul berbagai program dengan
teknologi baru yang luar biasa fitur-fiturnya.

Kamu bisa menginsta ROM yang dimodifikasi, akan tetapi pada
sistem operasi Android sendiri memiliki cukup banyak jenis custom
ROM. Tenang sga hal tersebut dijamin tidak membahayakan
perangkat smartphone.

OS Android memiliki keunggulan dibandingkan dengan sistem operasi

lainnya seperti salah satunya i0S yang dipunyai milik Apple, dimana
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IOS hanya dapat digunakan oleh produk dari Apple sendiri. Adapun
Android  dapat digunakan  berbaga merek  smartphone
seperti Samsung, Sony Ericsson, Motorola, dan HTC.

9. Widget yang ada di homescreen bisa diakses dengan berbagai setting,
cepat dan juga mudah

b) Kekurangan Android

1. Sistem operasi Android tampaknya menuntut pengguna untuk harus
memiliki koneks internet dalam keadaan aktif. Seperti minimanya
perlu koneks internet GPRS, hal ini agar perangkat siap untuk online
sesuai dengan kebutuhan pengguna.

2. Memang terdapat banyak Aplikas Android yang dapat digunakan
secara gratis, akan tetapi seringkali pada aplikasi yang digunakan
akan memunculkan iklan yang cukup mengganggu.

3. Batera pada smartphone dengan sistem Android akan sangat boros
dibandingkan OS lainnya, hal tersebut disebabkan dengan banyaknya
proses yang berjalan secara background yang membuat energi baterai
menjadi cepat habis

2.6 AdobeFlash Professional CS6

Menurut (Maulana |, 2014) pada dasarnya baik Flash verss Macromedia
maupun vers Adobe, area kerjanya terbagi menjadi beberapa bagian, di

antaranya menu, toolbox, timeline, stage, dan panel.

2.6.1 Toolbox
Di dalam toolbox terdapat macam-macam tool yang bisa kita gunakan
untuk menggambar objek. Toolbox ini terdiri dari beberapa bagian
yaitu selection tool, drawing tool, painting tool, dan navigation tool.
Seperti pada gambar 2.1 berikut:
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Gambar 2.1 Toolbox

2.6.2 Timdine
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Timeline pada Adobe Flash CS5 secara default terletak diatas stage.
Timeline berfungsi untuk mengontrol keseluruhan objek dan animasi

yang terdapat pada stage, seperti pada gambar 2.2 berikut :

Gambar 2.2 Timeline

Layer

Layer dapat diilustrasikan seperti tumpukan-tumpukan yang beris
objek di dalamnya. Dengan layer, kita bisa mengatur movie pada
stage dan menentukan kedalaman atau lapisan suatu objek, seperti
pada gambar 2.3 berikut :

Vimeic e Chutymat :-ﬁ._]m I
= a0 5 1
l 7 0.
Gambar 2.3 Layer

Untuk menambahkan layer baru, kita dapat memilih menu Insert >
Timenline > Layer atau dengan mengklik icon yang terdapat pada

bagian bawah timeline.
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Terdapat beberapa mode yang dapat dipilih padalayer di ataranya:
Guide layer, berfungs untuk membuat animas dengan
menggunakan jalur atau track berupa garis yang telah dibuat.
Motion layer, digunakan untuk membuat pergerakan animas
tween.

Masking layer, digunakan untuk membuat animasi efek
masking.

2.6.4 Frame
Frame merupakan bagian dari layer yang digunakan untuk mengatur
pergerakan animasi. Di dalam frame bisa terdiri dari teks, gambar,
audio,video, dan kode program ActionScript, seperti pada gambar 2.4
berikut :

Timeline | Output | Compiler Errars | Meotion Editor |
s @ 0 __5 10
! 4 3 § olelel3

Gambar 2.4 Frame

Frameterdiri dari beberapa bentuk, di antaranya:
Keyframe, frame vyang memiliki bentuk bulatan hitam,
menandakan bahwa di dalamnya terdapat objek.
Blank keyframe, frame berbentuk bulat putih, menandakan bahwa
frame masih kosong.
Action frame, frame dengan bulatan putih dan terdapat huruf ‘a’,
menandakan di dalamnya terdapat kode program ActionScript.
Frame label, yaitu frame yang diberi nama label dan ditandai
dengan bendera warna merah.

2.6.5 Stage
Stage adalah area putih berbentuk kotak yang terletak ditengah area
kerja Flash. Seperti istilah stage pada panggung teater, stage di dalam

Flash berfungsi untuk menampilkan semua objek maupun movie yang



20

berjalan diatasnya. Objek yang diletakan pada stage bisa berupa teks,
gambar, dan video, seperti pada gambar 2.5 berikut :

Gambar 2.5 Sage

2.6.6 Panel Properties
Panel ini menampung semua properti yang terdapat pada tool-tool
dadam Flash. Untuk mengaktifkannya, pilih menu Windows >
Properties, seperti pada gambar 2.6 berikut :

...... =|
Frame )]
L
wr LABEL
Kame:
Type: | I
wr SOLND
Name: | Nons |

Effect:

Mo sound selected

Gambar 2.6 Panel Properties
2.6.7 Pan€ Libary
Seperti layaknya perpustakaan, library pada Flash berfungs
menampung semua simbol yang telah dibuat maupun hasil impor dari

file luar seperti audio, video, gambar, dil. Untuk menampilkan panel
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library, bisamelalui menu Window > Library atau dengan menekan

tombol CTRL+L, seperti pada gambar 2.7 berikut :

| Proptien ey | -=]
[ Untitled-1 il = &

Esnsty ey fs] .4
MName - | A5 Linkage

Gambar 2.7 Panel Libary
2.6.8 Panel Action
Panel ini berfungsi sebagai tempat menuliskan ActionScript. Untuk
mengaktifkannya, pilih menu Window > Action atau menekan tombol
F9, seperti pada gambar 2.8 berikut :

Actonsaipt 3.0 R ABYE G T Fltogesiopen y B

f.controls bsbClanses

fl.contrels progressfiarClanses | | =

B R o] |8 tovera:s(i
=) | lne 10F 1. Col1

Gambar 2.8 Panel Action

2.7 ActionScript 3.0

Menurut (Maulana |, 2014) ActionScript 3.0 atau disingkat AS3 merupakan
bahasa pemrograman yang bekerja pada Adobe Flash, Flex, dan
FlashDevelop. ActionScript 3.0 pertama kali dirilis pada tahun 2006
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2.8

2.9

bersamaan dengan diluncurkannya Flash versi 9 sekaligus Flash pertama
yang kini telah diakuisisi oleh Adobe System Inc. yaitu Adobe Flash CS3.

ActionScript 3.0 adalah bahasa pemrograman yang didasarkan pada
ECMAScript, yaitu standar bahasa pemrograman yang dikembangkan oleh
ECMA (Europan Computer Manufacturers Association). Dengan standar ini,
AS3 mampu melakukan integrasi data yang cepat dengan berbagali bahasa

pemrograman lainnya seperti JavaScript dan XML.

Adobe Photoshop CS

(Hartono D.S, 2013), Adobe Photoshop adalah perangkat lunak editor citra
buatan Adobe System yang dikhususkan untuk pengeditan foto/gambar dan
pembuatan efek. Perangkat ini banyak digunakan oleh fotografer digital dan
perusahaan iklan sehingga dianggap sebagai pemimpin besar (market leader)
untuk perangkat lunak pengolah gambar/foto, dan bersama Adobe Acrobat,
dianggap sebaga produk terbaik yang pernah diproduksi oleh Adobe System.
Vers kedelapan aplikasi ini disebut dengan nama Photoshop CS (Creative
uite), versi sembilan disebut Adobe Photoshop CS2, versi kesepuluh disebut
Adobe Photoshop CS3, versi kesebelas disebut Adobe Photoshop CH4, versi
keduabelas disebut Adobe Photoshop CS5, dan versi yang terakhir
(ketigabel as) adalah Adobe Photoshop CS6.

Adobe AIR

(Seno, 2014) Menguraikan bahwa, Adobe Air ( Adobe Integrated Runtime)
adalah sebuah cross operating system runtime yang dikembangkan oleh
Adobe sehingga memungkinkan pengembang memanfaatkan ketrampilan
mereka (seperti Flash, Flex, HTML,Javascript dan PDF) untuk membangun
RIA (Rich Internet Aplication) dan contenya kedalam platform baru.
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08 Adobe AIR Setup = .S

Adobe® AIR®
4 Installation com pheted.
Adobe ALR has bean sudcassfully inalalled

Gambar 2.9 Adobe AIR Setup

210 Metode Prototype
(Rosa A.S dan M. Shalahuddin, 2015) Menguraikan bahwa, Model prototipe
(prototyping model) dimulai dari mengumpulkan kebutuhan pelanggan
terhadap perangkat lunak yang akan dibuat. Lalu dibuatlah program
prototipe agar pelanggan lebih terbayang dengan apa yang sebenernya
diinginkan. Program prototipe biasanya merupakan program yang belum
jadi. Program ini biasanya menyediakan tampilan dengan simulasi alur
perangkat lunak sehingga tampak seperti perangkat lunak yang sudah jadi.
Program prototipe ini dievalusa oleh pelanggan atau user sampai ditemukan
spesifikas yang sesuai dengan keinginan pelanggan atau user. Berikut

adalah gambar dari model prototipe:
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Mendengarkan
Pelanggan

Membangun
Memperbaila

Pelanggan
Melthat Menguji

Mock-Up

Gambar 2.10 Model Prototipe

Mock-up adalah sesuatu yang digunakan sebagai model desain yang
digunakan untuk menggar, demonstrasi, evaluasi desain, promosi, atau
keperluan lain. Sebuah mock-up disebut sebagai prototipe perangkat lunak
jika menyediakan atau

mampu mendemonstrasikan sebagian besar fungsi sistem perangkat lunak
dan memungkinkan pengujian desain sistem perangkat lunak. Iterasi terjadi
pada pembuatan prototipe sampal sesuai dengan keinginan pelanggan
(customer) atau user. Proses pada model prototyping dapat dijelaskan
sebagai berikut:

a. Pengumpulan kebutuhan : Developer dan klien bertemu dan menentukan

tujuan umum, kebutuhan yang diketahui dan gambaran bagian-bagianyang
akan dibutuhkan berikutnya.

. Perancangan : Perancangan dilakukan cepat dan rancangan mewakili

semua aspek perangkat lunak yang diketahui, dan rancangn ini menjadi
dasar pembuatan prototype.

Evaluas prototype : Klien mengevaluas prototype yang dibuat dan
digunakan untuk memperjelas kebutuhan perangkat |unak.Perulangan
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ketiga proses ini terus berlangsung hingga semua kebutuhan terpenuhi.
Prototype-prototype dibuat untuk memuaskan kebutuhan klien dan untuk
membangun perangkat lunak lebih cepat, namun tidak semua prototype
bisa dimanfaatkan. Demi kebutuhan klien lebih baik prototype yang dibuat
diusahakan dapat dimanfaatkan.

2.11 Unifed Modeling Languange (UML)
2.11.1 Pengertian UML

(Haviluddin, 2011) Menguraikan bahwa, Unified Modeling Language
(UML), adaah suatu dat untuk memvisualisaskan dan
mendokumentasikan hasil analisa dan desain yang berisi sintak dalam
memodelkan system secara visual juga merupakan satu kumpulan
konvenss pemodelan yang digunakan untuk menentukan atau
menggambarkan sebuah system software yang terkait dengan objek.
Sgarah UML sendiri terbagi dalam dua fase sebelum dan sesudah
munculnya UML. Dalam fase sebelum, UML sebenarnya sudah mulai
diperkenalkan sgiak 1990an namun notas yang dikembangkan oleh
para ahli anlisis dan desain berbeda-beda, sehingga dapat dikatakan
belum memiliki standarisas. UML menyediakan notasi-notasi yang
membantu memodelkan sistem dari berbagai perspektif. UML tidak
hanya digunakan dalam pemodelan perangkat lunak, namun hampir

dalam semua bidang yang membutuhkan pemodel an.

2.11.2 Diagram UML
Model-model diagram dapat dikelompokkan berdasarkan sifatnya

yaitu statis dan dinamis. Jenis diagram tersebut antaralain:
1. Diagram Use case
(Haviluddin, 2011) Menguraikan bahwa, Use Case Diagram
merupakan diagram yang menggambarkan actor (pengguna atau
sistem lain), use case (deskripsi fungsi dari sebuah sistem) dan
relasinya. Use Case adalah abstraksi dan interaksi antara system

dan actor. Use Case bekerja dengan cara mendeskripsikan tipe
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interaks antara user sebuah sistem dengan sistemnya sendiri
melalui sebuah cerita bagaimana sebuah sistem dipakai. Use Case
merupakan konstruksi untuk mendeskripsikan bagaimana sistem
akan terlihat di mata user. Sedangkan Use Case diagram
memfasilitas komunikasi diantara analis dan pengguna serta

antara analis dan client.

Tabel 2.1 Simbol Use Case Diagram

Simbol Keterangan

Use Case Fungsionalitas yang disediakan sistem

sebagal unit-unit yang saling bertukar
pesan antar unit atau aktor, biasanya akan
diterangkan dengan menggunakan kata
kerjadi awal frase nama use case.

Aktor/Actor Orang, proses, atau sistem lain yang
berinteraksi dengan sistem informasi yang
akan dibuat, jadi simbol aktor belum tentu
menunjukkan orang, biasanya akan
dinyatakan menggunakan kata benda
diawal frase nama aktor.

Nama aktor
Asosiasi/Association Komunikasi antara aktor dan use case
yang berpartisipas pada use case atau use
case memiliki interaksi dengan aktor.
Ekstensi/Extend Case tambahan memiliki nama depan

yang sama dengan use case Yyang
<<extend>> ditambahkan, misalnya




Tabel 2.2 Simbol Use Case Diagram (Lanjutan)

Simbol

K eterangan

Generaisasi/generalization

P>

Hubungan generalisasi dan spesiaisas
(umum-khusus) antara dua buah use case
dimana fungs yang satu adalah fungsi
yang lebih umum dari lainnya.

2. Activity Diagram
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(Haviluddin, 2011) Menguraikan bahwa, Activity diagram

menggambarkan kegiatan diagram alur kerja atau aktivitas dari

sistem. Activity diagram menggambarkan aktivitas dalam sistem

yang sedang dirancang, bagaimana masing-masing alir berawal,

decision yang mungkin terjadi, dan bagaimana aktivitas itu

berakhir. Activity diagram juga dapat menggambarkan proses

parael yang mungkin terjadi pada beberapa eksekusi yang
dijalankan dari sebuah sistem.

Tabel 2.3 Simbol Diagram Activity

Simbol K eterangan
Status Awal Status awal aktivitas sistem, sebuah
‘ diagram aktivitas memiliki status awal.
Aktivitas Aktivitas yang dilakukan sistem.
Biasanya diawali dengan kata kerja.
Percabangan/Decision Asosiasi  penggabungan dimana lebih

dari satu aktivitas.




Fork Digunakan untuk menunjukkan
1 kegiatan yang dilakukan secara parael.

N

Tabel 2.4 Simbol Diagram Activity (Lanjutan)

Simboal Keterangan
Penggabungan/Join Digunakan untuk menunjukkan
kegiatan yang digabungkan.
End Point Mengakhiri aktivitas sistem.

3. Sequence Diagram

(Rosa A.S dan M. Shaahuddin, 2015) diagram sekuen
menggambarkan kelakuan objek pada use case dengan
mendeskripsikan  waktu hidup objek dan message yang
dikirimkan dan diterima antar objek. Oleh karena itu untuk
menggambarkan diagram sekuen maka harus diketahui objek-
objek yang terlibat dalam sebuah use case beserta metode-metode
yang dimiliki kelas yang diinstansias menjadi objek itu.
Membuat diagram sekuen juga dibutuhkan untuk melihat scenario
yang ada pada use case. Banyaknya diagram sequen yang harus
digambar adalah minimal sebanyak pendefinisian use case yang
memiliki proses sendiri atau yang penting semua use case yang
telah didefinisikan interaksi jalannya pesan sudah dicakup pada
diagram sekuen sehingga semakin banyak use case yang
didefiniskan maka diagram sekuen yang harus dibuat juga
semakin banyak.
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(Rosa A.S dan M. Shalahuddin, 2015) simbol-simbol yang ada
pada diagram sekuen dapat dilihat pada Tabel 2.5 berikut.

Tabel 2.5 Simbol Sequence Diagram

Simbol Keterangan
Garis hidup/lifeline Menyatakan kehidupan suatu objek.
Objek Menyatakan objek yang

nama objek : nama kelas berinteraks pesan.

Waktu aktif Menyatakan objek dalam keadaan
aktif dan berinteraksi, semua yang
terhubung dengan waktu aktif ini
adaah sebuah tahapan yang
dilakukan di dalamnya.

Pesan tipe create Menyatakan suatu objek membuat
<<create>> objek yang lain, arah panah
> mengarah pada objek yang dibuat.
Pesan tipe call Menyatakan suatu objek
1: nama _metode() memanggil operasi/metode yang
> ada pada objek lain atau dirinya
sendiri.
Pesan tipe send Merupakan bahwa suatu objek
mengirimkan
1 : masukan data/masukan/informasi ke objek
lainnya, arah panah mengarah pada
objek yang dikirim.
Pesan tipe return Menyatakan bahwa suatu objek
yang telah menjadankan suatu
1 : keluaran operasi atau metode menghasilkan
________________ > suatu kembalian ke objek tertentu,

arah panah mengarah pada objek
yang menerimakembalian.
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Tabel 2.6 Simbol Sequence Diagram ( Lanjutan )

Simbol

Keterangan

Pesan tipe destroy
<<destroy>> :

X

Menyatakan suatu objek
mengakhiri hidup objek yang lain,
arah panah mengarah pada objek
yang diakhirim sebaliknya jika ada
create maka ada destroy.

Aktor

atau

nama_aktor

Orang, proses, atau sistem lain
yang berinteraks dengan sistem
informasi yang akan dibuat di luar
sistem informas yang akan dibuat
itu sendiri, jadi walaupun simbol
dari aktor adalah gambar orang,
tapi aktor belum tentu merupakan
orang; biasanya dinyatakan
menggunakan kata benda di awal
frase nama aktor.

Penomoran pesan berdasarkan urutan interaksi  pesan.
Penggambaran letak pesan harus berurutan, pesan yang lebih atas
dari lainnya adalah pesan yang berjalan terlebih dahulu. Semua
metode di dalam kelas harus ada di dalam diagram kolaborasi atau
sekuen, jika tidak ada berarti perancangan metode di dalam kelas
itu kurang baik. Hal ini dikarenakan ada metode yang tidak dapat

dipertanggung jawabkan kegunaannya.




212 Penditian Terdahulu
Adapun Secara ringkas jurna penelitian yang berhubungan dengan penelitian
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penulis diantaranya terdapat pada tabel 2.7 berikut:

Tabel 2.7 Pendlitian Terdahulu

No | Nama Sampai Judul Tanun Keterangan
Terbit
1 Syafdan | RANCANG 2016 Pengolahan pisang paska panen ini
Muza BANGUN sangat ditemui disekitar kita, mula
Perdana | APLIKASI dari produksi pisang sampai
PENGOLAHA penemuan—penemuan baru dari ibu-
N BUAH ibu PKK (Pembinaan Kesgjahteraan
PISANG Keluarga) tentang pengolahaan
PASKA pisang paska panen yang menjadi
PANEN ciri  khas jganan di provins
BERBASIS lampung, timbulnya UKM (Usaha
MOBILE Kecil Menengah) vyang ingin

memulai usaha baru dengan bahan
baku
pengolahan pisang sangat pesat di

pisang. Perkembangan
provinsi lampung, oleh sebab itu
semakin bermacam-macam
pengolahan pisang tersebut, seperti
dapat diolah menjadi keripik, pie
pisang, sale pisang dan pisang bolen
serta masih banyak lagi pengolahan
pisang yang belum diketahui.

Penelitian ini  menggunakan studi
kepustakaan yang bersumber dari
UKM di Bandar Lampung. Metode
pengembangan perangkat  lunak
yang digunakan adalah model
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Prototype. Aplikas dibuat dengan
menggunakan bahasa pemrograman
HTML 5 dan jQuery Mobile sebagai
User Interface, kemudian
menggunakan framework Phonegap
yang berfungs untuk merubah
aplikas  berbasis web menjadi
aplikas berbasis mobile yang dapat
dijalankan pada Sistem Operasi
Mobile Android. Aplikasi ini dapat
menampilkan informasi mengenai
pengolahan buah pisang, cara
mendaftarkan usaha baru, tips dan
trik tentang buah pisang.

Aplikasi Pengolahan Buah Pisang
Paskah Panen dapat memberikan
informasi kepada  masyarakat
tentang pengolahan buah pisang,
memberi informas cara memulai
usaha baru, menjadi media aternatif
bagi masyarakat untuk mendapatkan
informasi  mengenai tata cara
pengolahan buah pisang, memilih
buah pisang, dan memberikan
informasi cara mendaftarkan usaha
baru di Disperindag.

INTAN
KOMAL
A DEWI

RANCANG
BANGUN
PANDUAN
PENGOLAHA
N

SINGKONG

2016

Panganan tradisional merupakan
panganan asli Indonesia yang harus
dikembangkan dan dijaga
keberadaanya di tanah air. Singkong
adalah bahan panganan tradisiona

yang memiliki komoditas besar.
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ONIGIRI
VARIASI
BERBASIS
ANDROID

Sehingga diperlukan media panduan
pegolahan bahan panganan
tradisional singkong untuk diolah
menjadi makanan yang modern,
tidak kalah saing dengan makanan
dari luar negeri dan pantas untuk
disgikan dalam acara-acara tertentu.
Penelitian ini  bertujuan  untuk
memberikan panduan dasar bagi
masyarakat tentang tata cara
pengolahan  singkong.  Metode
pengembangan dalam aplikasi ini
mengunakan metode Prototype yang
memiliki beberapa tahapan vyaitu
pengumpulan kebutuhan,
perancangan dan evaluasi.

Y ang dihasilkan dalam penelitian ini
adalah aplikas panduan pengolahan
singkong onigiri variasi yang dapat
dijadikan sebagai media yang
fleksibel untuk membantu
penyuluhan dinas pertanian tanaman
pangan dan hortikultura serta dapat
dijadikan sebagai sarana alternative
daam panduan pembuatan produk
singkong onigiri  varias  secara
digital,selain itu dapat
membangkitkan motivasi
masyarakat dalam mengolah bahan
dasar panganan tradisional menjadi
lebih modern.




